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VERITAS  Veritas Backup Exec 22: Administration

CODE: LENGTH: PRICE:

VER_BE22-A 40 Hours (5 days) kr40,000.00

Description

Acquire the skills to make your data protection strategy successful with the Veritas Backup Exec 22: Administration course. The
course is designed for the data protection professional tasked with deploying, configuring, maintaining, and managing a Backup
Exec environment. The course covers Backup Exec concepts, how to back up and restore critical data, configure storage devices
and media, and work with various Backup Exec agents and options, which protect applications like Microsoft Exchange, Microsoft
SharePoint, Microsoft SQL, Microsoft 365, Active Directory, Cloud, Oracle, and Virtual environments.

Objectives

By the completion of this course, you will be able to:

* Describe the functionality and architecture of Backup Exec.

* Install and upgrade to Backup Exec 22.

« Configure storage devices — Cloud-based storage and Network storage.

» Backup data to and restore data from disk, network, and the Cloud.

* Perform tape devices and tape management.

* Manage servers and jobs.

» Set backup and recovery settings and methods.

» Work with the Database Encryption Key.

* Perform online Disaster Recovery.

* Install the SDR disk creation wizard, create an SDR disk image and recover a server with SDR.
» Back up a physical machine and convert to a virtual machine either simultaneously or on a schedule.
* Install, configure, and manage the Backup Exec Central Admin Server feature.

» Configure Backup Exec Deduplication Storage.

* Protect remote servers using the appropriate remote agents, applications, and databases.
» Use Backup Exec to protect databases and applications, including;

o Microsoft Hyper-V

o Microsoft SQL Server

o Microsoft Exchange

o Microsoft SharePoint

o Microsoft 365

o Active Directory

o Oracle

* Protect virtual environments.

+ Perform virtual machine conversions.

Audience

This course is designed for system administrators, system engineers, technical support personnel, consultants, backup
administrators, backup operators, and others who are responsible for installing, configuring, managing, and monitoring Backup
Exec 22.

Prerequisites

You must have a basic working knowledge of administrating and configuring Windows Server 2016 and later platforms. Basic
working knowledge of the following applications is beneficial, but not required:

* Microsoft SQL Server

* Microsoft Exchange Server

* Microsoft SharePoint Portal Server

* Microsoft Hyper-V
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* VMware virtual infrastructure.
* Oracle

* Cloud Technologies

» Microsoft 365

Programme

Licensing Backup Exec

* Subscription, Perpetual, and Custom Licensing Installing Backup Exec

* Trialware and Upgrades » Backup Exec: New installation
Backup Exec Fundamentals » Capacity and subscription license enforcement « Typical Installation of Backup Exec
» Data Backup Basics » Updating Licensing Information » Custom Installation of Backup Exec
» Backup Exec Solution Offerings < Capacity Widget and Capacity Metering * Installation Details
» Backup Exec Architecture * Maintenance and Extended Support Licensing * Applying Backup Exec Updates
Labs Working with the Backup Exec Administration Console
» Exercise A: Installing Veritas Backup Exec * Installing and Configuring the Backup Exec Administration Console
» Exercise B: Verifying the Veritas Backup Exec Installation « Using the Backup Exec Administration Console
» Exercise C: Adding Backup Exec Licenses » Exploring the Backup Exec Administration Console
» Exercise D: Configuring and Running Veritas Update * Introduction to Backup and Restore
» Exercise E: Viewing the Backup Exec License * Introduction to BEMCLI
Labs
» Exercise A: Installing the Backup Exec Remote Administration Console Disk Storage Devices
» Exercise B: Exploring the Home tab of the Backup Exec Administration Console < Backup Exec Storage Devices
» Exercise C: Working with the Configuration Task Widget * Viewing disk storage: Storage View
« Exercise D: Exploring the Backup Exec Administration Console * Disk Cartridge Devices
* Exercise E: Creating a Configured View * Deduplication Disk Storage
« Exercise F: Creating a Disk Storage * Importing a Legacy Backup-to-disk Folder
* Exercise G: Creating a Basic Backup Job » Backup Exec Storage Pools
* Exercise H: Creating a Basic Restore Job » Windows Storage Pool and Spaces
Labs

* Exercise A: Creating a Disk Storage Device Using the Configuration Wizard

« Exercise B: Viewing the Disk Storage in the Backup Exec Management Command Line Interface

* Exercise C: Viewing Disk Storage Device Properties

* Exercise D: Creating a Storage Pool

Cloud-based Storage Devices

* Basics of Cloud storage Support in Backup Exec

» Amazon S3 Cloud-based Storage

» Google Cloud-based Storage

* Microsoft Azure Cloud-based Storage

» Backup Exec Cloud Deduplication

« Configuring a Cloud-storage Device in Backup Exec

» Managing Cloud-storage in Backup Exec

Labs

« Exercise A: Configuring Generic S3 Compatible Cloud

Storage in Backup Exec

« Exercise B: Backing up data to Generic S3 Cloudbased Storage

« Exercise C: Configuring Deduplication on Generic S3 Compatible Cloud Storage
Disk and Network Data Management
* Data Lifecycle Management Fundamentals
* DLM Rules: Overview

Network Storage Devices » Dependent Backup Sets

* Network Storage Devices * DLM Dependent Rules

» OpenStorage Devices (Third-party deduplication) ¢« Manual Expiration and Retention

» Backup Exec Remote Media Agent for Linux * Read-only Setting

* NDMP Servers * Media Catalogs
Tape Devices and Tape Management
* Tape Storage

Labs * Managing Tapes

 Exercise A: Manually Performing Two Sets of Full and Incremental Backups * Robotic Libraries

« Exercise B: Manually Expiring the Backup Sets * Tape Storage Operations

* Exercise C: Retaining Backup Sets and Changing the Expiration Date of a Backup Set  Tape Storage: Alerts
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Backing Up Data

Labs * Preparing for Backups

« Exercise A: Inventorying Robotic Libraries when Backup Exec Services Start « Adding a Server

» Exercise B: Configuring Barcode Rules for a Robotic Library * Creating a Backup Job

» Exercise C: Assigning a Cleaning Slot to a Robotic Library * Multi-server Backups

* Exercise D: Understanding Storage Default Values * Accounts and Credentials in Backup Exec
» Exercise E: Viewing Default Media Sets * Managing Server Selections

* Exercise F: Creating a Media Set » Backup Selections

» Exercise G: Creating a Media Vault » Excluding Files from the Backup
 Exercise H: Assigning a Media Set to a Media Vault » Backup Settings

* Exercise |: Assigning Tapes to a Media Set » Backup Stage Basics

* Exercise J: Backing up to Tape « Job Name Fundamentals

» Exercise K: Restoring from Tape * Manually Running Backup Jobs
Labs

» Exercise A: Adding a Server

« Exercise B: Backing Up Files and Folders

* Exercise C: Creating a One-time Backup Job

» Exercise D: Creating a New Backup Job Using the Settings from an Existing Backup

» Exercise E: Backing up Multiple Servers Managing Servers and Jobs
» Exercise F: Backing up System State » Backup and Restore View
» Exercise G: Working with Backup Methods * Server Groups

» Exercise H: Adding a Stage to a Backup * Tag as Business-Critical

Restoring Data
» Contents of a Backup Set

Labs * Restore Job Basics

» Exercise A: Creating a Server Group * Restore Settings

» Exercise B: Viewing Server Details * Granular Restore Technology (GRT)
» Exercise C: Tagging a Resource as Business-critical and Backing it up * Restoring Data

» Exercise D: Tagging a Resource as Business-critical from the Include/Exclude Window + Online Disaster Recovery

» Exercise E: Examining Pre-defined and Custom Reports * Restoring System State

» Exercise F: Viewing Job Log Details » Shadow Copy Components

Labs

* Exercise A: Viewing the Contents of a Backup Set

« Exercise B: Restoring Data to the Default Location

« Exercise C: Restoring Data to an Alternate Location

» Exercise D: Restoring File and Folder Permissions

* Exercise E: Restoring Data Using the Search Wizard

» Exercise F: Restoring Data to a VHD Working with the Database Encryption Key

* Exercise G: Restoring Data Directly from a Disk » Backup Exec Database Sensitive Data Components

« Exercise H: Restoring Data from a Tape Backup * Auto-generated AES-256 Encryption Key

* Exercise |: Restoring a Business-Critical Resource + Protecting the Database Encryption Key (DEK)
Simplified Disaster Recovery
« Simplified Disaster Recovery Fundamentals

Labs « Simplified Disaster Recovery: Backup

» Exercise A: Viewing the Database Encryption Key * Installing the SDR Disk Creation Wizard
« Exercise B: Viewing the Database Encryption Key and Attempting to Back itup < Creating an SDR Disk Image (.iso) file

« Exercise C: Exporting the Database Encryption Key * Recovering a Server with SDR

» Exercise D: Backing Up and Restoring the Database Encryption Key » Windows Storage Pools and Spaces
Labs

* Exercise A: Adding a Server

« Exercise B: Viewing and Identifying Critical System Devices

* Exercise C: Creating a Simplified Disaster Recovery Enabled Backup Job

* Exercise D: Performing a Complete Online Restore of a Computer — Walkthrough

» Exercise E: Creating a Simplified Disaster Recovery Disk

* Exercise F: Recovering appsrv1 Using the SDR Disk

Upgrading Backup Exec

* Basics of Upgrading the Backup Exec Server

« Standard and Rolling Upgrade — Backup Exec Labs

» Agent for Windows Upgrade * Exercise A: Upgrading Veritas Backup Exec
» Migration Report * Exercise B: Upgrading the Agent for Windows
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Central Admin Server Feature

» Backup Exec CAS: Overview

* Installing the CAS

* Installing the Managed Backup Exec Server (MBES)

* Instant Recovery Jobs in a CAS Environment

* MBES Settings

» Backup Jobs: MBES and Server Pools

* Restoring Files using CAS

» Copying Configuration to MBES

* Instant Recovery jobs in a CAS environment

* MBES Settings

» Copy Configuration to MBES

» Upgrading a CAS Environment to Backup Exec 22

* Renaming CAS and MBES

* MBES to Standalone

« Offline Central Admin Server Restore from a Managed Backup Exec Server
Labs

» Exercise A: Installing the CAS Feature

» Exercise B: Converting a Backup Exec Server to a Managed Backup Exec Server
» Exercise C: Viewing the Settings for a Managed Backup Exec Server

» Exercise D: Creating a Backup Exec Server Pool

» Exercise E: Restoring Data from CAS

» Exercise F: Using Optimized Duplication with the Central Admin Server

» Exercise G: (Optional) Changing the CAS Storage and Media Data Location for MBES
» Exercise H: (Optional) Running the Backup Exec Utility for CAS Operations
Deduplication Feature

» Data Deduplication and Open Storage Technology: Fundamentals

* Deduplication Feature Option

» Configuring Backup Exec Deduplication Storage

» Exclusion from Windows Deduplication

* Deduplication Backup Job

* Configuring Client-side Deduplication

* Rehydration

* Optimized Duplication

* Protecting the Backup Exec Deduplication Storage

* Best Practices for the Deduplication Feature

» OpenStorage devices (Third-party deduplication)

* OpenDedupe OST Connector

» OpenDedupe Installation and Configuration

« Configuring OpenStorage in Backup Exec

» Upgrading from Backup Exec 21 to Backup Exec 22

Labs

« Exercise A: Verifying the Deduplication Feature Installation

« Exercise B: Creating a Deduplication Storage Folder

« Exercise C: Creating a Backup Job to Backup Data to the Deduplication Disk Storage (Server-side deduplication)
« Exercise E: Verifying Data Deduplication

» Exercise F: Restoring Deduplication Data

« Exercise G: Creating a Client-side Deduplication Job

Security and Compliance Features Labs

» Backup Exec Support for GDPR * Exercise A: Working with the GDPR Guard Feature
» Backup Exec Support for Ransomware Resilience * Exercise B: Working with the Ransomware Resilience Feature
Remote Agent, Applications, and Databases

» Agent for Windows: Fundamentals Labs

* Installing the Agent for Windows « Exercise A: Viewing Backup Exec License Information

* Managing the Agent for Windows * Exercise B: Installing the Agent for Windows

» Agent for Applications and Databases: Fundamentals * Exercise C: Viewing the Agent for Windows Installation Footprint
* GRT Support for Agent, Applications, and Databases * Exercise D: Backing Up a Remote Windows Computer

» Enabling the Agent for Applications and Databases Feature ¢ Exercise E: Restoring Data to a Remote Windows Computer
Protecting Microsoft Exchange Server

« Installing the Backup Exec Agent for Microsoft Exchange

* Backing up a DAG

» Exchange Backup Selections

* Exchange Backup Settings

» Exchange Preferred Servers Only Backups

* Restoring Exchange data

* Redirected Restore Considerations

» VSS Providers and Exchange Writers
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Labs

* Exercise A:
« Exercise B:
« Exercise C:
« Exercise D:
« Exercise E:
Labs

« Exercise A:
« Exercise B:
« Exercise C:
Labs

« Exercise A:
« Exercise B:
 Exercise C:
« Exercise D:
* Exercise E:
» Exercise F:
Labs

* Exercise A:
» Exercise B:

Protecting Microsoft SQL Server

Viewing the Exchange DAG Configuration + Agent for Microsoft SQL Server: Fundamentals
Backing Up an Exchange DAG * Microsoft SQL Backup Selections

Restoring Exchange Mailbox Items » Backing up a Microsoft SQL Server

Restoring Exchange Mailbox Items Using Search * Restoring a Microsoft SQL Server Database

Performing a Redirected Restore of Exchange Databases and Logs ¢ Supported Microsoft SQL Server Features
Protecting Microsoft SharePoint Server

Backing up SQL Server System Databases » Agent for Microsoft SharePoint: Fundamentals

Restoring a SQL Server Database « Backing up Microsoft SharePoint

Restoring a SQL Server Database to an Alternate Location < Restoring Microsoft SharePoint

Viewing the SharePoint Site Details

Backing Up SharePoint

Performing a SharePoint GRT Restore for a Task Protecting Microsoft Active Directory

Performing a SharePoint Redirect Restore for a Document « Agent for Microsoft Active Directory: Fundamentals
Restoring a Versioned Document * Traditional Active Directory Restore

Restoring a SharePoint Portal Site * Active Directory: Granular Recovery Technology

Backing up Microsoft Active Directory
Restoring Active Directory Objects

Protecting Microsoft 365

* Integrated Microsoft 365

» Support for Backing Up Microsoft 365 Tenant Data

* Restoring Microsoft 365 Tenant Data

* Notes And Best Practices For Microsoft 365Protecting Virtual Environments — Part 1
* Virtualization Technologies

» Backup Exec Virtualization Agents

* Installing Agent for VMware and Hyper-V

» Backing up Virtual Machines

* Restoring Virtual Machines

Labs

* Exercise A:
» Exercise B:
» Exercise C:
» Exercise D:
* Exercise E:

Verifying the Agent for VMware and Hyper-V Installation
Connecting to and Viewing the ESX Server Configuration
Adding the vCenter Server to Backup Exec

Backing up an ESXi Server

Restoring a VMware Virtual Machine

Protecting Virtual Environments — Part 2

* Instant Cloud Recovery for Hyper-V and VMware

* Instant Recovery for Hyper-V and VMware Virtual Machines

* Performing an Instant Recovery for a Virtual MachineRemoving an Instantly Recovered Virtual Machine
* Instant Recovery Resiliency

« Virtual Machine Recovery Ready Validation

Labs

* Exercise A:
» Exercise B:
» Exercise C:
« Exercise D:
* Exercise E:

Performing an Instant Recovery of a Windows Virtual Machine

Performing an Instant Recovery of a NonWindows Virtual Machine

Removing Instantly Recovered Virtual Machines

Creating a Validate Virtual Machine for a Recovery Job for a Windows Virtual Machine
Creating a Validate Virtual Machine for a Recovery Job for a Non-Windows Virtual Machine

* Exercise F: Working with the Virtual Machine Backups Widget

« Exercise G:

Backing Up a Virtual Machine Skipping PageFile.sys

Performing Virtual Machine Conversions

« Conversion

to Virtual Machine: Fundamentals

» Backup and then Convert Workflow

» Backup and Simultaneously Convert Workflow

» Convert to a Virtual Machine from a Point-in-time
* One-time Convert to Virtual Machine

* Virtual Conversion Options Labs

 Conversion Considerations * Exercise A: Performing a Backup and then a Virtual Conversion
Agent for Linux and UNIX Labs

» Agent for Linux * Exercise A: Installing the Agent for Linux

* Installing the Agent for Linux < Exercise B: Backing up a Linux Server

* Backing up Linux Servers * Exercise C: Restoring Data to Linux Computers

» Agent for Linux: Best Practices * Exercise D: Restoring Data to an Alternate Location
* Linux References * Exercise E: Configuration Options for Linux Computers
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Agent for Oracle

* Agent for Oracle on Windows or Linux Servers

* Installing the Oracle Agent on Windows or Linux Servers

* Configuring the Oracle Agent on Windows or Linux Servers

* Authenticating Credentials on the Backup Exec Server

» Backing up Oracle Databases

* Restoring Oracle Databases

* Best Practices for Backup Exec Agent for Oracle on Windows and Linux Servers

Labs

« Exercise A: Verifying the Backup Exec Remote Agent (RALUS) Installation on the Linux Server
« Exercise B: Configuring the Oracle Agent on the Linux Server

» Exercise C: Performing Oracle Database Backup

* Exercise D: Restoring Data

« Exercise E: Performing a DBA-Initiated Backup Job

* Exercise F: Installing and Configuring Backup Exec Remote Media Agent (RMAL) on the Linux Server

Further Information

Duration

* Instructor-led training - ILT: 5 days, including 6
months of lab access

* Virtual instructor-led training - VILT: 5 days, including

6 months of lab access Hands-On
* Learning Lab — Self-paced lesson guide plus 6 This course includes practical, hands-on lab exercises that
months of lab access enable you to test your new s

Session Dates

Date Location ;::2 Language Type Guaranteed PRICE
17 Jun Virtual Classroom (GMT / BST English Instructor Led kr40,000.00
2024 UTC) Online

Tilleggsinformasjon

Denne treningen er ogsa tilgjengelig som trening pa stedet. Kontakt oss for & finne ut mer.

Page 7 of 7





